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1. Bienvenido a Sion Tower

Bienvenido a Sion Tower, un videojuego de estrategia y acción en 3D ambientado en un mundo fan-
tástico compatible con sistemas GNU/Linux y Windows. A lo largo de estas páginas podrás conocer los
detalles sobre la historia y la ambientación del juego. Más adelante encontrarás los requisitos mínimos,
de forma que puedas saber si tu equipo podrá ejecutarlo sin problemas. A continuación se ofrece una
completa guía de instalación para los dos sistemas operativos soportados. Por supuesto, este manual
contiene todos los detalles sobre el control y las posibilidades de Sion Tower. Finalmente encontrarás
información detallada sobre cómo crear tus propios escenarios y añadirlos al juego.

Figura 1: Logo de Sion Tower

1.1. Historia

El gremio de magos está localizado en la Torre Sagrada, Sion Tower. Allí viven, estudian los libros de
hechizos, celebran sus ritos secretos y protegen innumerables riquezas. Un día, el gremio al completo
abandona la Torre para celebrar un ritual en el bosque cercano. Protagonista, protagonista de Sion To-
wer es el único que permanece en el edificio sagrado para protegerlo. A pesar de ser un joven iniciado e
inexperto, no iba a suceder nada porque el resto se ausentase durante unas horas.

La imprudencia del gremio resulta ser completamente desastrosa y una horda de monstruos no tarda en
rodear Sion Tower. La misión del joven aprendiz consiste en detener la invasión piso por piso de la
Torre. ¡Debe evitar que roben la Reliquia Sagrada!

1.2. Protagonista

Protagonista es pertenece a una de las categorías inferiores del gremio, los iniciados. Se le reconoce
fácilmente por su pequeña estatura y sus ropas sencillas. Es un simple estudiante de magia en la Torre
Sagrada y lleva tiempo tratando de hacerse un hueco entre sus superiores a base de esfuerzo y entrega.
La invasión de la Torre es, en cierta medida, una gran oportunidad para Protagonista de mostrar su
valía. No obstante, está muerto de miedo, nunca se había visto obligado a emplear sus poderes en una
situación tan extrema.
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Figura 2: Protagonista de Sion Tower

Características físicas:

Vida: 100

Maná: 100 (regeneración automática)

Velocidad: 5m/s

Hechizos: Bola de fuego, Furia de Gea y Ventisca.

1.3. Enemigos

Los enemigos de Sion Tower son monstruos abominables de procedencia desconocida. No obstante, su
objetivo es claro: eliminar al gremio de magos y robar la Reliquia Sagrada, una leyenda de grandioso
poder. Cada enemigo tiene unas características visuales y físicas determinadas (mostradas en la tabla in-
ferior) aunque su comportamiento es similar. Todos tratan de encontrar a los supervivientes para acabar
con ellos.

El Goblin es una criatura de mente muy básica, verde, enana y muy desagradable. Sólo va equipado
con una tosca espada corta y un burdo taparrabos. No son extremadamente duchos en combate pero sí
cuentan con una gran velocidad. Su gran ventaja es el número, son capaces de utilizar su superioridad
numérica para atosigar al enemigo y acabar con él.

Figura 3: Goblin
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El Diablillo es una criatura venida del propio averno y bastante superior al Goblin en lo que a propieda-
des físicas se refiere. Sus garras, alas y cola de demonio les basta para atacar desgarrando la carne que
se encuentra a su paso, no necesitan ningún tipo de arma adicional.

Figura 4: Diablillo

El Golem de hielo es una criatura de gran tamaño venida de las montañas heladas del norte. Su estructura
corporal está formada por piedra maciza y bloques de hielo. Es una de las criaturas más lentas que existen
pero sus golpes son demoledores.

Figura 5: Golem de hielo

Nombre del enemigo Vida Daño Velocidad
Goblin 5 10 5

Diablillo 7 15 4.5
Golem de hielo 10 20 2

Cuadro 1: Comparativa de características de enemigos
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1.4. Hechizos

Los hechizos son el único arma de Protagonista para detener el avance de los enemigos. Sus conoci-
mientos mágicos no le permiten hacer un enorme despliegue de proyectiles devastadores. Debe admi-
nistrar cuidadosamente su limitada energía mágica (maná) para convocar débiles cúmulos de energía.

Con Bola de fuego puedes invocar un proyectil mágico que abrase a tus enemigos a su paso. Furia de
Gea convoca la propia fuerza de la naturaleza para volverla en contra de cualquier criatura. Finalmente,
Ventisca lanza varios proyectiles mágicos helados y afilados como cuchillas.

Nombre del hechizo Maná Daño Velocidad
Bola de fuego 2 3 8
Furia de Gea 3 6 8

Ventisca 4 8 8

Cuadro 2: Comparativa de atributos de hechizos

2. Requisitos mínimos

Para poder disfrutar de Sion Tower sin problemas necesitas disponer de un equipo con unas caracterís-
ticas iguales o superiores a las que se listan a continuación:

Sistema operativo: GNU/Linux, Windows XP Service Pack 2, Windows Vista o Windows 7.

Procesador: Pentium 2GHz o AMD.

Memoria: 100 MB de memoria RAM disponibles.

Tarjeta de vídeo: 128 MB de memoria y aceleración 3D.

Espacio en disco: 100 MB.

Control: ratón y teclado.

En caso de utilizar un sistema operativo GNU/Linux y experimentar problemas, revisa que tengas insta-
lada la última versión de los drivers para tu tarjeta gráfica y que éstos soportan aceleración por hardware.

3. Descarga e instalación

En esta sección se proporcionan las indicaciones pertinentes para que puedas descargar e instalar Sion
Tower en tu sistema. En primer lugar, debes acudir a la sección de ficheros del repositorio del juego en
la forja de RedIRIS:

http://forja.rediris.es/frs/?group_id=820

Simplemente descarga la versión de Sion Tower que coincida con tu sistema. No se han publicado
binarios para GNU/Linux, por lo que utilizas dicho sistema, tendrás que descargar el paquete con el
código fuente y compilarlo tú mismo. En las página 7 encontrarás más información al respecto.
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3.1. Instalación en GNU/Linux

Para poder jugar a Sion Tower en un sistema operativo GNU/Linux es necesario descargar e instalar
el entorno de desarrollo completo ya que, por el momento, no se distribuyen binarios del software. El
videojuego cuenta con las siguientes dependencias:

libogre-dev

libsdl1.2-dev

libsdl-mixer1.2-dev

mygui

A lo largo del proceso de instalación, supondremos que se posee una distribución basada en Debian
que dispone de la utilidad apt-get. De no ser así, el proceso será similar utilizando el programa
equivalente para instalar paquetes en la distribución correspondiente. En primer lugar, Debemos instalar
todas las dependencias de OGRE3D, entre las que se encuentran el compilador GCC, la herramienta
make o el generador de makefiles CMake. Para ello utilizamos la siguiente orden:

sudo apt-get install g++ make libfreetype6-dev libboost-date-time-dev \
libboost-thread-dev nvidia-cg-toolkit libfreeimage-dev zlib1g-dev \
libzzip-dev libois-dev libcppunit-dev doxygen libxt-dev libxaw7-dev \
libxxf86vm-dev libxrandr-dev libglu-dev cmake

Una vez instaladas las dependencias podemos dirigirnos a la web oficial de OGRE3D y descargar el
código fuente para sistemas GNU/Linux.

http://www.ogre3d.org/download/source

El siguiente paso consiste en descomprimir el paquete y acceder al directorio resultante utilizando la
terminal. La herramienta CMake nos ayuda a generar un fichero makefile dependiente de nuestra
plataforma de manera muy sencilla. Para generarlo el makefile, compilar e instalar OGRE3D introduci-
mos la siguiente secuencia de órdenes:

cmake.
make
sudo make install

Instalar LIBSDL y LIBSDL MIXER es muy sencillo puesto que usualmente se encuentran en los reposi-
torios de la distribución. Simplemente introducimos:

sudo apt-get install libsdl1.2-dev libsdl-mixer1.2-dev

Finalmente procedemos a la instalación de la biblioteca MYGUI. Hemos de acudir a su sección de fi-
cheros en la forja SourceForge y descargar la versión 3.2.0 Release Candidate 1.

http://sourceforge.net/projects/my-gui/files/MyGUI/

Cuando finalice la descarga, descomprimimos el paquete en formato zip y accedemos al directorio re-
sultante utilizando la terminal. En este caso también generaremos un makefile de forma automática con
CMake para después compilar e instalar a través de make.

cmake .
make
sudo make install
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Llegados a este punto habremos finalizado instalando las dependencias de Sion Tower. Ahora simple-
mente es necesario acceder a su directorio mediante la terminal y comenzar con la compilación. Una vez
finalizada con éxito, podremos ejecutarlo.

make
./siontower

3.2. Instalación en Windows

Tras descargar el paquete, utiliza cualquier programa de compresión/descompresión que soporte el for-
mato zip. Si no tienes ninguno instalado, puedes emplear 7Zip sin problemas ya que es Software Libre.
Para descargarlo, dirígete a la siguiente dirección:

http://www.7-zip.org

Sion Tower es completamente portable y autocontenido, así que si lo prefieres puedes guardarlo en un
lápiz de memoria o en cualquier disco duro externo. Para iniciar el juego, haz doble click sobre el fichero
ejecutable siontower.exe.

4. Guía de juego

En este bloque el jugador novel podrá aprender cómo se juega a Sion Tower. Recorreremos las pantallas
de la aplicación explicando la funcionalidad de cada una de forma que aprenderemos a crear y gestionar
perfiles de jugadores, seleccionar nivel, controlar al personaje guiándolo hacia su objetivo y progresar
sumando puntos o desbloqueando nuevos escenarios.

4.1. Menú principal

Justo al iniciar Sion Tower se nos presenta el menú principal del juego con un paisaje montañoso en el
que se ve a la Torre Sagrada siendo atacada por enemigos en medio de una intensa lluvia.
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Figura 6: Menú principal de Sion Tower

Desde esta pantalla podemos llevar a cabo las siguientes acciones:

Jugar: nos lleva a la pantalla de selección de perfil y al camino para comenzar una partida.

Créditos: nos muestra una escena con las personas que han participado en el desarrollo.

Salir: cierra el juego por completo, ¿seguro que quieres dejar de jugar?

4.2. Selección de perfil

Sion Tower cuenta con un sistema de perfiles para que varias personas puedan jugarlo y controlar su
progreso. Al comienzo de la partida sólo está disponible el primer nivel. Cuando finalices con éxito un
escenario, el siguiente nivel se convertirá en accesible. Además, cada perfil cuenta con una puntuación
que mide nuestras habilidades en el juego. Esta puntuación puede subir o bajar en función de nuestra
actuación en las partidas. Esto permite que varios usuarios compitan en una máquina de forma asíncrona
para alcanzar la máxima puntuación.
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Figura 7: Pantalla de selección de perfil en Sion Tower

La pantalla de selección de perfil consta de dos paneles bien diferenciados. Selección de un perfil ya
existente y creación de un nuevo perfil. En el primer bloque puedes visualizar la experiencia y los ni-
veles desbloqueados de cada jugador pulsando con el ratón sobre sus nombres. Si tu perfil se encuentra
en la lista y quieres utilizarlo tienes que seleccionar el nombre y pulsar el botón Aceptar. Es posible
eliminar un perfil de la lista con el botón Eliminar. No obstante, hay que ser cautelosos, puesto que un
perfil eliminado no es recuperable.

Cuando quieras crear un nuevo perfil, escribe su nombre en el panel inferior y pulsa sobre Crear. Al
menos debes introducir algún carácter y el nombre elegido no debe figurar entre los perfiles existentes,
de lo contrario se mostrará un error.

Para volver al menú principal de Sion Tower puedes pulsar sobre el botón Atrás.

4.3. Selección de nivel

Tras seleccionar nuestro perfil se nos presentará la pantalla de selección de nivel. En la lista de niveles
aparecen todos los existentes, ya estén bloqueados o disponibles. Los bloqueados para nuestro perfil lo
indican en rojo y su icono es translúcido.
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Figura 8: Pantalla de selección de nivel en Sion Tower

Para seleccionar un nivel, pulsa con el ratón sobre su icono. Si deseas volver a la pantalla de selección
de perfil, pulsa sobre Atrás.

4.4. Partida

Tras seleccionar el nivel comienza la partida y los enemigos aparecen en pequeñas oleadas. El objetivo
consiste en eliminarlos a todos utilizando nuestra energía mágica (maná) para invocar hechizos y man-
tener nuestra energía vital por encima de cero.

Figura 9: Partida de Sion Tower

Los controles son los siguientes:
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Movimiento: para mover al personaje, utiliza las teclas W, A, S y D.

Cámara: la cámara siempre hace un seguimiento al personaje para que nunca salga del encuadre.
Puedes acercar o alejar la cámara utilizando la rueda del ratón. También puedes moverla alrededor
del personaje moviendo el ratón mientras pulsas el botón derecho.

Hechizos: para lanzar un hechizo apunta con el ratón en la dirección deseada y pulsa el botón
izquierdo. Si tienes maná suficiente lanzarás el hechizo seleccionado. Para cambiar de hechizo,
pulsa sobre el que quieras seleccionar en el menú de juego. También puedes hacer uso de las teclas
de acceso rápido: 1, 2 y 3.

Pausa: para activar la pausa puedes pulsar la tecla escape o el botón del menú de juego. En el
menú de pausa puedes Reanudar la partida, volver a la pantalla de Selección de nivel o dirigirte
al Menú principal.

Si pasas el ratón por encima de un hechizo puedes acceder a más información sobre el mismo: nom-
bre, descripción, maná necesario y daño que causa. Cuando no tengas maná suficiente para lanzar un
hechizo determinado, éste se mostrará en gris. La energía mágica se recupera progresivamente de forma
automática cuando no se está haciendo uso de ella. No es posible recuperar vida a lo largo de la partida.

Figura 10: Menú de pausa en Sion Tower

Si nuestra energía se termina por completo habremos perdido la partida y se nos avisará mediante un
cartel. Mientras decides si volver a intentarlo puedes seguir moviendo la cámara y observando cómo los
enemigos han alcanzado la victoria. Si pulsas la barra espaciadora volverás a la pantalla de selección
de nivel.
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Figura 11: Mensaje de derrota en Sion Tower

4.5. Pantalla de victoria

Al eliminar a todos los enemigos de un nivel habrás completado con éxito el escenario y llegarás a
la pantalla de victoria en la que el personaje celebra su logro. Si no estabas jugando al último nivel
disponible, habrás conseguido desbloquear el siguiente. Tanto la puntuación obtenida como los niveles
desbloqueados se guardan automáticamente en este punto.

Figura 12: Pantalla de victoria en Sion Tower

La puntuación de Sion Tower se obtiene mediante la suma de los siguientes factores:

Enemigos: por cada enemigo eliminado se obtienen puntos. Cuanto más poderoso sea el enemigo,
mayor será la recompensa en forma de puntos.
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Vida: recibimos un complemento por la energía que nos quede al finalizar la partida con éxito.

Maná: en el juego se valora mucho la puntería y la administración del maná o energía mágica.
Cuanto menos maná utilicemos, mayor será la puntuación. Es posible que si se malgasta demasia-
do, la puntuación sea negativa.

Tiempo: recibimos recompensa en forma de punto por eliminar a los enemigos lo antes posible,
este apartado también puede recibir una valoración negativa.

Tras terminar con éxito un nivel puedes elegir la opción Volver a jugar, volver a la pantalla de Selección
de nivel o regresar al Menú principal.

4.6. Créditos

En la pantalla de créditos aparece una escena de la Torre Sagrada con un panel listando los participantes
en el desarrollo de Sion Tower. Cuando desees volver puedes pulsar el botón Atrás.

Figura 13: Autores de Sion Tower

5. Creación de niveles

¿Tienes una gran idea para un nuevo nivel de Sion Tower? ¿Sabes como puedes mejorar sustancialmente
la historia? ¿Te gustaría que todos viesen tus ideas? El motor del videojuego permite a los usuarios crear
y añadir nuevos niveles de manera muy sencilla utilizando la herramienta de modelado y animación 3D
libre por excelencia: Blender. El proceso es largo pero sencillo, sobre todo si sigues detenidamente todos
los pasos de este manual.

5.1. Instalación de Blender y complementos

Blender es la herramienta de modelado y animación 3D de carácter completamente libre más potente que
existe. Utilizando Blender se han producido en su totalidad cortos de animación como Big Buck Bunny1,

1Big Buck Bunny: http://bigbuckbunny.org
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Sintel2 o videojuegos como Yo Frankie!3. Blender es multiplataforma, no importa si posees Windows,
Mac o GNU/Linux ya que no tendrás problema alguno para utilizarlo. Recientemente se ha publicado
la serie 2.5 de la herramienta, que incluye mejoras como un cambio radical de la interfaz. No obstante,
los scripts de exportación necesarios funcionan en la 2.49, por tanto, esa sera la versión que utilizaremos.

Figura 14: Fotograma del cortometraje Sintel

Si utilizas un sistema operativo GNU/Linux basado en Debian, es probable que Blender se encuentre en
los repositorios de tu distribución. En tal caso, bastaría con introducir en una terminal:

sudo apt-get install blender

En caso de contar con un sistema operativo de tipo Windows, debes acudir a la sección de versiones
anteriores de Blender y descargar el instalador:

http://download.blender.org/release/Blender2.49a/blender-2.49a-windows.
exe

Simplemente abre el instalador haciendo doble click sobre el ejecutable, sigue los pasos indicados y
habrás instalado Blender con éxito.

En ambos sistemas operativos es necesario instalar un plugin de exportación que convierte una escena
creada con Blender a un fichero de texto en formato xml procesable por el motor de Sion Tower. El
formato se conoce como Dotscene y es ampliamente utilizado. Así mismo, es necesario otro comple-
mento que convierte un modelo creado con Blender a un xml. Es posible descargar ambos plugins desde:

http://ogreaddons.svn.sourceforge.net/viewvc/ogreaddons/trunk/blender\
sceneexporter/ogredotscene.py

http://ogre.svn.sourceforge.net/viewvc/ogre/branches/v1-6/Tools/BlenderExport

Para instalar los exportadores en sistemas GNU/Linux, hemos de copiar los ficheros descargados en:

2Sintel: http://sintel.org
3Yo Frankie!: http://yofrankie.org
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/.blender/scripts

En cambio, si utilizamos Windows el directorio será:

[Instalación de Blender]/.blender/scripts

5.2. Composición del nivel

Para seguir esta guía con soltura es recomendable que poseas unos conocimientos mínimos sobre Blen-
der. Deberías saber cómo manejar los elementos básicos de la interfaz y la forma de manipular los
objetos dentro de la escena: movimiento, rotación, escala, duplicado, etc. Si nunca has utilizado Blender
con anterioridad es recomendable que acudas a algún manual para principiantes como el libro gratuito
bajo Creative Commons Aprende Blender en 24 horas4 del profesor certificado por la Blender Founda-
tion Carlos González Morcillo.

5.2.1. Crear un nuevo documento

El primer paso es crear un nuevo documento de Blender, para ello simplemente abrimos la herramienta
por primera vez o hacemos click sobre File → New y aceptamos eliminar la escena actual. Para comenzar
no podemos tener objetos presentes por lo que seleccionamos toda la escena con A y eliminamos con X.

Figura 15: Creación de un nuevo documento en Blender

Es recomendable contar con un espacio de trabajo cómodo, la disposición de las vistas tridimensionales
de Blender es fundamental. Para crear un nuevo nivel lo ideal es contar con las vistas frontal, lateral,
cenital y libre. Puedes ver un ejemplo de esta disposición en la figura 15.

5.2.2. Convenciones de nombrado

En un escenario de Sion Tower se dan cita varios tipos de elementos: objetos del escenario, geome-
tría arbitraría, efectos de partículas, oleadas de enemigos, etc. Blender no distingue entre ellos, para la
herramienta de modelado todos son objetos tridimensionales comunes. Hemos de seguir unas reglas de

4Aprende Blender en 24 horas: http://www.inf-cr.uclm.es/www/cglez/downloads/blender/
24hBlenderYafray.pdf
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nombrado especiales para que el motor sepa distinguir entre una mesa que forma parte del mobiliario y
un icono simbólico que representa la llegada de un enemigo.

Durante todo el proceso de creación del escenario es importante prestar atención para que los objetos
tengan un nombre acorde con las reglas establecidas. En la pestaña de edición (tecla F9) aparece el panel
Link and Materials mostrando el nombre de la malla del objeto y el del propio objeto. En nuestro caso,
objetos semejantes comparten la misma malla mientras que el nombre de cada objeto debe ser distinto y
ajustarse a las reglas. Puedes verlo en la figura 16.

Figura 16: Nombre de una puerta en un escenario

Las reglas de nombrado son las siguientes:

Escenario: todos los elementos del escenario (paredes, suelo, mesas, sillas y otros muebles) si-
guen la regla scene-nombre.numero. El nombre del objeto es lo que lo identifica dentro del
catálogo para poder recuperar su modelo de colisión y el número ayuda a hacerlo único dentro de
la escena (dos objetos no pueden tener el mismo nombre). Ejemplo: scene-door.005.

Efectos de partículas: puedes incluir efectos de partículas en cualquier punto de la escena. La
regla es particle-nombre.numero. Ejemplo: particle-flame.001.

Luces: el motor del juego reconoce las luces de manera automática, por lo que no debes preocu-
parte de sus nombres.

Malla de navegación: la malla de navegación indica a los enemigos cuales son las zonas transi-
tables del escenario y siempre debe llamarse navMesh. Veremos más sobre las mallas de nave-
gación en secciones posteriores.

Enemigos: los enemigos siguen la regla enemy-tipo-t.numero. La letra t representa el se-
gundo en el que aparecerá el enemigo desde que se inicia la partida. Ejemplo: enemy-goblin-25.001.

Protagonista: el elemento cuyo nombre sea player definirá la posición inicial del jugador den-
tro del nivel.

Geometría arbitraria: toda la geometría que no siga la convención de nombrado será tratada
como complementos del escenario. No se calcularán colisiones contra ellos (se podrán atravesar).

5.2.3. Enlazar objetos

Los escenarios del juego están repletos de objetos de distintas clases y puedes reutilizarlos sin ningún
tipo de problemas para tus propias creaciones. Incluir los objetos ya creados para Sion Tower en tu
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nuevo nivel es muy sencillo. En el menú de Blender seleccionamos File → Append or Link (Image
Browser). Se abrirá un pequeño navegador de ficheros para que seleccionemos el objeto.blend a
importar. Al abrirlo, tendremos que seleccionar Object y el nombre del objeto creado en Blender.

Figura 17: Enlazar con un objeto de Blender existente

Al enlazarlo se añadirá al origen de coordenadas el objeto deseado. No obstante, los datos de su malla
pertenecen a un fichero externo (contorno azul) y lo deseable es convertirlo en local. De esta manera
nuestro proyecto de nivel no contará con indeseables dependencias externas. Para hacerlo seleccionamos
el objeto con el botón derecho del ratón, pulsamos L y seleccionamos la opción All. Una vez localizado,
podremos mover el objeto, escalarlo y rotarlo por la escena con total libertad.

Figura 18: Convertir en local un objeto enlazado

5.2.4. Elementos del escenario

Los elementos del escenario son aquellos objetos que cuentan con un modelo de colisión. Esto quiere
decir que ni el protagonista ni los hechizos podrán atravesarlos. Los objetos que venían incluidos en Sion
Tower ya tienen un modelo de colisión asignado y para utilizarlos sólo hemos de enlazarlos siguiendo
los pasos de la sección anterior. Estos objetos se encuentran en [siontower]/media/blender y
la lista completa junto a sus códigos es la siguiente:
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Cama (bed)

Candelabro (candle)

Columna (column)

Muro con arco (door)

Muro con puerta (door2)

Muro (wall)

Suelo 8x8m (floor8x8)

Suelo 4x4m (floor4x4)

Reliquia (reliq)

Silla (chair)

Taburete (roundchair)

Estanterías (shelves)

Escaleras (staircase)

Mesa (table)

Caja de madera (woodenbox)

Cuando enlacemos un objeto y lo convirtamos en local podemos moverlo utilizando la tecla G, rotarlo
con R o escalarlo mediante S. Las tres operaciones anteriores pueden restringirse a uno de los tres ejes.
Por ejemplo, para desplazar una mesa a lo largo del eje X será necesario seleccionar la mesa con el botón
derecho del ratón, pulsar G, pulsar X y desplazarla. Es necesario que no haya desniveles y que el nivel
del suelo esté situado en el plano Z = 0 de Blender

Basta con enlazar al principio cada objeto y duplicarlo cada vez que deseemos uno semejante. En Blen-
der es posible duplicar objetos seleccionando el elemento a duplicar y pulsando SHIFT + D. No obs-
tante, dicha operación conlleva tener redundancias en los datos de la malla y lo que deseamos es contar
con dos instancias de la misma malla. Para duplicar elementos utilizaremos la combinación ALT + D.
Con estas sencillas instrucciones ya posees los conocimientos suficientes para componer escenas como
la de la figura 19.

Figura 19: Elementos del escenario ya colocados
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5.2.5. Nuevos objetos

Puedes añadir nuevos objetos que no estén en el catálogo modelados por tí mismo o que hayas encon-
trado en algún banco de recursos libres. Una vez modelado y texturizado, será necesario que lo exportes
en un formato compatible con el motor gráfico del juego OGRE3D, el formato binario .mesh. Puedes
obtener más información sobre la exportación en IberOgre:

http://wikis.uca.es/iberogre/index.php/Exportar_modelos_desde_Blender

Los modelos exportados se sitúan en el directorio [siontower]/media/meshes, los materiales
en [siontower]/media/materials y las texturas en [siontower]/media/textures. El
último paso consiste en definir el modelo colisionable del nuevo elemento del escenario. Debes acudir
al fichero xml [siontower]/media/levels/bodycatalog.xml y editarlo de forma manual.

Cada objeto cuenta con un nombre único y tiene asociado un cuerpo (body) compuesto por una o más
formas (shapes). Los objetos tienen un tipo, pueden ser 1 (suelo) o 2 (mobiliario). Cada forma es una
figura geométrica sencilla:

Esfera: sphere, definida por un centro y un radio.

Plano: plane, definido por un punto y un vector perpendicular.

Caja alineada: aabb, un hexaedro alineado con los ejes, definido por un centro y unas distancias
hasta sus lados.

Caja orientada: obb, hexaedro al que se le ha aplicado una rotación, definido por un centro,
distancias hasta los lados y los ejes sobre los que se apoya.

Ha de añadirse una nueva entrada por cada objeto nuevo que se añada si se desea que cuente con un
modelo colisionable. La sintaxis del fichero xml es bastante sencilla.

1 <?xml version="1.0" encoding="UTF-8" ?>
2 <bodies>
3

4 <body name="floor8x8" type="1">
5 <shape type="plane">
6 <position x="0" y="0" z="0" />
7 <normal x="0" y="1" z="0" />
8 </shape>
9 </body>

10

11 <body name="chair" type="2">
12 <shape type="obb">
13 <center x="0" y="-0.036" z="0.147"/>
14 <extent x="0.2275" y="0.4675" z="0.21"/>
15 <axes a00="1" a01="0" a02="0" a10="0" a11="1"
16 a12="0" a20="0" a21="0" a22="1" />
17 </shape>
18 </body>
19

20 </bodies>
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5.2.6. Efectos de partículas

Como ya se ha mencionado anteriormente, los efectos de partículas siguen la nomenclatura particle
-nombre.numero. Lo ideal es representarlos mediante pequeñas esferas de un color relacionado con
el efecto que generan. En Sion Tower se incluyen tres tipos de sistemas de partículas por defecto:

flame: llama del tamaño adecuado para ser utilizada en las antorchas.

flame2: llama del tamaño adecuado para colocarse sobre los candelabros.

rain: lluvia intensa utilizada en el menú principal del juego.

Figura 20: Esfera simbolizando un sistema de partículas

Los sistemas de partículas se definen en scripts de extensión .particle almacenados en el directorio
[siontower]/media/particles. Si conoces la sintaxis, puedes añadir los que desees para utili-
zarlos en tus propios niveles. Hay herramientas como Ogre Particle Editor5 que permite generar dichos
scripts utilizando una interfaz gráfica sencilla.

5.2.7. Iluminación

Añadir luces a una escena es imprescindible, de lo contrario esta aparecería completamente oscura den-
tro del juego. Para hacerlo pulsa la barra espaciadora dentro de la escena 3D y selecciona Add → Lamp
y uno de los tipos de luces aceptados por Sion Tower: Lamp, Sun y Spot. No tienes porqué preocuparte
por ninguna convención de nombrado en este caso. Una vez hayas añadido la luz, puedes moverla por la
escena como desees.

Es posible configurar varios parámetros de cada punto de luz como su intensidad y color accediendo al
panel de sombreado (F5) y al subpanel de controles de luz. Lo recomendable es que ninguna luz ascienda
de 1,0 en intensidad y que los colores sean suaves.

5Ogre Particle Editor: http://www.ogre3d.org/tikiwiki/OGRE+Particle+Editor&structure=
Tools
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Figura 21: Panel de configuración de luces

5.2.8. Malla de navegación

La malla de navegación es un conjunto de triángulos conectados que definen un área transitable para los
enemigos. En Sion Tower los monstruos no podrían encontrar el camino hacia el personaje si no fuera
por la malla de navegación. Es similar a contar con un tablero repleto de casillas conectadas. Una vez
tengamos claro dónde se colocarán los obstáculos podemos ir creando la malla. Recuerda que el objeto
debe llamarse navMesh (se distingue entre mayúsculas y minúsculas). El nombre de la propia malla
debe ser único entre las mallas del juego, lo normal es llamarla navMesh-número donde número es
la posición del nivel en la historia.

Figura 22: Creación de la malla de navegación

Para comenzar a crear la malla puedes añadir un plano pequeño con la barra espaciadora, Add → Mesh
→ Plane. Entra en modo edición utilizando el tabulador y selecciona uno de los vértices con el botón
derecho para eliminarlo con X. Asegúrate de que la malla siempre permanece en el suelo, es importante
para que los enemigos no se eleven misteriosamente. Debe estar formada exclusivamente por triángulos,
no pueden existir cuadriláteros.

Extender la malla es sencillo, selecciona un vértice y pulsa E para extruirlo creando uno nuevo y una
arista de unión. Ve repitiendo la operación para cubrir las zonas transitables del escenario y recuerda
dejar un margen prudencial con los obstáculos. Debes crear caras entre los grupos de tres vértices que
formen los triángulos, para hacerlo selecciona los tres vértices y pulsa F. Al finalizar es imprescindible
que todas las caras de la malla miren hacia el mismo lado (arriba o abajo), para conseguirlo, selecciona
todos los vértices con A y pulsa Ctrl + N.

22



Finalmente, debes exportar la malla para que el motor de Sion Tower pueda procesarla. Selecciona la
malla fuera del modo edición (pulsa el tabulador) y accede a File → Export → OGRE Meshes.

Figura 23: Exportación de la malla de navegación

El nombre del material es irrelevante porque no nos hará falta, asegúrate de marcar la opción Fix Up
Axis to Y y elegir el directorio [siontower]/media como destino de la exportación.

5.3. Enemigos y jugador

Los enemigos suelen representarse mediante una pirámide de base cuadrada en posición horizontal. Co-
mo ya hemos mencionado, la nomenclatura para los enemigos es enemy-tipo-t.numero siendo
los tipos posibles: goblin, demon y golem. Para que el diseño de niveles sea más cómodo, los goblins
llevan asignado el color verde, los demonios el rojo y los gólems el azul aunque no es obligatorio de
cara a la exportación.

Tras añadir un enemigo, puedes duplicarlo utilizando la combinación SHIFT + D, moverlo con G y ro-
tarlo con R (aunque lo normal es hacerlo sobre el eje vertical únicamente). La pirámide de los enemigos
debe colocarse atravesando el suelo, de forma que el vértice superior esté en el punto 0 del eje Z.

Figura 24: Disposición de enemigos en el nivel

Debes añadir otro elemento simbólico como una esfera o cono para indicar la posición inicial del jugador.
Simplemente has de nombrarlo player.

5.4. Integración del nivel

Es conveniente que poco a poco vayas guardando tus progresos diseñando el nivel ya que no es extraño
equivocarse o dejar el trabajo a media. Para ello selecciona File → Save, elige una ruta y presiona el
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botón de guardado. A continuación se adjuntan las indicaciones para integrar el nivel que acabas de crear
en Sion Tower.

5.4.1. Script de exportación

Tras haber guardado el nivel como fichero .blend es el momento de proceder a la exportación a
formato DotScene. Para ello selecciona File → Export → Ogre Scene. Se desplegará un panel con
todos los elementos de la escena, si quieres que todos aparezcan en el nivel, pulsa sobre All. Recuerda
activar la opción Fix Up Axis To Y y selecciona el directorio de niveles como destino de la exportación:
[siontower]/media/levels.

Figura 25: Exportación de la escena

Por cada nivel existen dos ficheros xml, el primero es el de la escena y tiene como nombre codigo_scene.xml.
Por su parte, el segundo contiene información complementaria como el nombre del nivel, descripción y
música que sonará, su nomenclatura es codigo_info.xml. Por ejemplo, si el código del nivel que
deseamos exportar es level05, el nombre del fichero escena debería ser level05_scene.xml.

5.4.2. Añadir el nivel al juego

Para integrar el nuevo nivel dentro de Sion Tower debes crear un fichero codigo_info.xml en el
directorio [siontower]/media/levels. La sintaxis es muy sencilla, a continuación se muestra el
ejemplo para el primer nivel del juego. El fichero de música debe estar en formato OGG y estar situado
en [siontower]/media/music.

1 <?xml version="1.0" encoding="UTF-8" ?>
2 <basicInfo>
3 <name>The Hall</name>
4 <description>Some enemies have assaulted the main hall of\nthe Sacred

Tower. Stop the invasion!</description>
5 <song name="nivel1.ogg" group="" />
6 </basicInfo>

Como ya has visto en la página 10, en la pantalla de selección de nivel, cada escenario viene acompañado
de un icono. Si no haces nada, el hueco quedará vacío para tu nuevo nivel. No obstante, si lo deseas, pue-
des añadir un fichero con nombre codigo.png al directorio [siontower]/media/textures.
Finalmente, debes añadir tu nuevo nivel al fichero que indexa los niveles, [siontower]/media/levels/levels.xml.
Por ejemplo, si añadiésemos el quinto nivel de nuestro ejemplo anterior, el fichero quedaría de la siguien-
te manera.
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1 <?xml version="1.0" encoding="UTF-8" ?>
2 <levels>
3 <level id="level01"></level>
4 <level id="level02"></level>
5 <level id="level03"></level>
6 <level id="level04"></level>
7 <level id="level05"></level>
8 </levels>

Con esto habrás conseguido añadir un nivel completamente nuevo y personalizado a Sion Tower. Para
comprobar que todo está correcto, inicia el juego y trata de seleccionar el escenario. Antes de compar-
tirlo con tus amigos, es recomendable que compruebes que ni es demasiado complicado ni demasiado
sencillo, ¡de lo contrario no sería divertido!
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